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1. Introduction 

1.1 Welcome to NiceLabel 
NiceLabel is a family of professional labeling software products that brings 
a complete bar code printing solution and RFID Smart Label printing to 
desktop, mobile and enterprise users. NiceLabel offers an easy-to-use 
interface and meets any label design and printing requirement for efficient 
label printing solutions to users in retail, logistics, health care, chemical, 
automotive and other industries. The main product lines include NiceLabel 
Suite, NiceLabel Pro, NiceLabel Express and Pocket NiceLabel. 

NiceLabel can be used with any 32-bit and 64-bit Windows operating 
system: Windows 2000, Windows XP, Windows Server 2003 and 
Windows Vista.  

The latest software version is available as a demo download on the 
NiceLabel Web site at www.nicelabel.com. 

1.2 NiceLabel Product Overview 

1.2.1 NiceLabel Standard Series 

NiceLabel Suite 

Complete software solution for any kind of label design and print 
requirement. Multiple connectivity options allow users to perform stand-
alone printing or integrate label printing into any network environment. 

NiceLabel Suite provides you with interactive label printing capabilities 
such as integrating label printing to existing applications (ActiveX) or non-
programming embedding of label printing to existing systems (NiceWatch). 

NiceLabel Suite includes the following modules: 

• NiceLabel Pro: Main application for label design and printing. 
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• NiceForm: Create your own custom designed data-entry 
applications without requiring any programming skills. 

• NiceWatch: Integrate and automate label printing to any existing 
information system. 

• NiceMemMaster: Download fonts and graphics to the 
computer’s memory card for optimized label printing. 

• NiceData: Manage your databases. 

• NicePrint: Manage fast and easy label printing. 

NiceLabel Pro 

Full-featured software designed for professional label design and printing, 
including complete database support and ActiveX integration possibilities. 
A wide range of features and options makes NiceLabel Pro a perfect and 
easy-to-use tool for any labeling requirement. 

NiceLabel Pro includes the following modules: 

• NiceLabel Pro: Main application for label design and printing. 

• NiceMemMaster: Download fonts and graphics to the 
computer’s memory card for optimized label printing. 

• NiceData: Manage your databases. 

NiceLabel Express 

Wizard-based software meeting basic barcode labeling needs. The entry-
level software includes many design elements of the Pro edition with the 
emphasis on simplified user interaction. 

NiceLabel Pro Print Only 

NiceLabel Pro Print Only offers printing of pre-designed labels but cannot 
be used to design and alter existing labels. Advanced settings for changing 
the labels are not available. 

NiceLabel Suite Print Only 

NiceLabel Suite Print Only offers printing of pre-designed labels, using 
pre-designed forms and automatic printing from pre-designed trigger 
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actions. NiceLabel Suite Print Only cannot be used to design and alter 
existing labels, forms and trigger configuration. Advanced settings for 
changing the labels are not available. 

NiceLabel Pocket PC Designer 

NiceLabel Pocket PC Designer is a software package for desktop Windows 
computers that brings the power of label and form design to portable 
Windows CE terminals. After you have designed the required labels on the 
desktop PC, synchronize the labels with and print them from the Windows 
Mobile Device. 

Pocket NiceLabel 

Pocket NiceLabel is a program package for Windows CE that brings the 
power of label printing to portable Windows CE computers (Windows 
Mobile Device). Pocket NiceLabel is part of the editions NiceLabel Suite 
or NiceLabel Pocket PC Designer. 

1.2.2 NiceLabel Enterprise Series 

NiceLabel Print Center 

NiceLabel Print Center is the enterprise solution for client/server based 
label printing and centralized system management. With label printing 
based on NiceLabel Pro, the Print Center consolidates the overview and 
management of the label design and printing to one central server. You can 
control the printing queues from one location, review events and enable 
alerts to keep you informed of the server status. 

NiceWatch Enterprise 

NiceWatch Enterprise is the enterprise solution for centralized integration 
of multi-threaded and high-volume label printing. NiceWatch Enterprise is 
based on the standard NiceWatch middleware module but provides with the 
NiceWatch Server module multiple print engines and a central server for 
trigger and printer monitoring and management. 
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Integrate label printing capabilities to the existing software and hardware 
systems. You can remove the processing bottleneck and print labels to any 
number of label printers using the multi-threaded print engine. 

1.2.3 NiceLabel Developer Series 

NiceLabel SDK 

NiceLabel SDK is an ActiveX integrator edition of the NiceLabel software 
developed for software publishers who need label printing capabilities in 
their software. NiceLabel SDK can be embedded in existing information 
systems or existing applications to provide support for label printing. 
NiceLabel SDK provides all label printing functionality of the NiceLabel 
software. 

NiceLabel WebSDK 

Similar to NiceLabel SDK the NiceLabel WebSDK edition is developed for 
software publishers who work with Web applications. NiceLabel WebSDK 
provides all label printing functionality of the NiceLabel software. 

1.3 NiceLabel Software Package 
Before you start installing the NiceLabel software check the content of the 
package to ensure it is complete. The package must include: 

- NiceLabel CD 

- Quick Start Guide 

- Key number on a sticker or a hardware key (not available with all 
editions) 

Please contact your software vendor if your package misses any of the 
mentioned items. 

1.4 About this Manual 
The NiceLabel Quick Start Guide helps you design and print labels quickly. 
The NiceLabel Quick Start Guide is an excerpt of the complete NiceLabel 
User Guide that you can obtain on the NiceLabel CD or online at 
www.nicelabel.com. 
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1.4.1 Typographical Conventions 

Text that appears in bold refers to menu names, file names like 
SETUP.EXE and buttons like the OK button. 

Text that appears in italic refers to confirming actions like Read only, 
locations like Folder or software window names. 

Text enclosed in <Less-Than and Greater-Than signs> refers to keys from 
the desktop PC keyboard like <Enter>. 

Variables are enclosed in [brackets] like [variable]. 

1.4.2 Software Restrictions 

All features explained in the Quick Start Guide are available in the 
NiceLabel Suite edition. However, some features are not available in the 
NiceLabel Pro or NiceLabel Express editions. Sections discussing features 
not available with NiceLabel Pro or NiceLabel Express will display an alert 
icon. 

 The feature is not available in NiceLabel Express. 

 The feature is not available in NiceLabel Pro. 
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2. Installation and Activation 

2.1 System and Software Requirements 

2.1.1 NiceLabel Single User Edition 

To run the program you need at least the following: 

• Pentium based computer with at least 64 MB of free RAM. 

• One of the 32-bit and 64-bit Windows operating systems: 
Microsoft Windows 2000, XP, 2003 and Vista. 

• Hard disk with 50 to 250 MB of free disk space (depending on the 
installation options). 

• CD-ROM drive. 

• Support for OLE DB database drivers. Recent Windows operating 
systems have included OLE DB database drivers. If your 
operation system does not have the database support, the 
installation wizard will prompt you to install it. 

• Administrator rights to the local computer during installation. 

2.1.2 NiceLabel Network Edition 

To run the Network Edition you need to fulfill the following: 

• All requirements for NiceLabel single user edition (see above). 

• Network interface card in each workstation. 

• Computer acting as a NiceLabel server. Any server operating 
system that allows file sharing with Windows system (any 
Windows, UNIX or Netware). 

• Each client must have granted full access (read, write, delete) to 
NiceLabel System folder on the server. 
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2.1.3 Pocket NiceLabel Edition 

To work with Pocket NiceLabel, you need to have the following: 

A. Desktop PC to design labels and forms with one of the following 
Windows operating systems: 

• Windows 2000 Professional with Service Pack 1 or higher 

• Windows XP 

• Windows 2003 

• Windows Vista 

B. Windows Mobile Device meeting the following requirements: 

• Installed ActiveSync Version 4.0 or higher 

• One of the following Windows operating systems: 

• Pocket PC 2003 

• PocketPC 2003 SE 

• Windows CE 4.2 (CF SP 1) 

• Windows CE 5.0 

• Windows Mobile 2005 

2.2 Installing NiceLabel Software 
When you put the NiceLabel CD in your CD-ROM drive, the 
installation/demonstration program will start automatically. You can 
browse the directory of the CD, look at the brochures and technical 
documentation, sample files and other documents.  

Note:  If you are using 2000, XP, 2003 or Vista, you have to log on as a 
user with administrator rights to be able to perform installation. 

2.2.1 Close all Software Applications 

To ensure complete installation of the NiceLabel software, close all open 
software applications before you start installing the NiceLabel software. 
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2.2.2 Run Installation 

Use the installation wizard to install NiceLabel software on your desktop 
PC. To install NiceLabel software, do the following: 

1. Put the NiceLabel CD in your CD-ROM drive. An installation window 
will open automatically. 

 
Running NiceLabel auto-run application from the CD 

Note: If the installation wizard does not start automatically, go to the 
main CD directory of your NiceLabel CD and double-click on 
the file START.EXE. 

2. Click on Install. A new window will open showing all NiceLabel 
editions.  
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Selecting NiceLabel edition for installation 

3. Click on the NiceLabel software you want to install. Follow the 
prompts. 

Note: Make sure to select the appropriate installation type in the 
installation wizard. The same installation wizard is used for all 
NiceLabel editions. 

2.2.3 Define Setup Options 

You can select the components of the selected NiceLabel edition that you 
want to install. You can choose among the following three types of 
installations: 

 

• Full Installation - installs all NiceLabel components in all 
available languages. 

• Compact Installation - installs only minimal set of components 
required for NiceLabel application to work correctly. Help and 
sample files are not installed. 
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• Custom Installation – gives you the option to select individual 
components for installation. 

To continue installation, do the following: 

1. Click on the Next button. 

2. Specify if shortcuts to NiceLabel software should be created on the 
desktop or in Quick Launch area. 

3. Click on the Next button. 

4. If you use Windows firewall, add some of the NiceLabel components to 
firewall exception list so they can communicate with the other 
components. It is recommended to leave the defaults unchanged. 

5. Click on the Next button then on the Install button to finish the 
installation. 

6. The Start menu in your Windows will show a new program group for 
the NiceLabel software that contains shortcuts for all NiceLabel 
applications. 

2.2.4 Install Printer Driver 

You can use the NiceLabel software to design and print labels to standard 
office printers (laser, inkjet or matrix) or to professional label printers 
(thermal printers). If you own a thermal printer, you have to install the 
appropriate printer driver before you can print with the label printer. You 
will find NiceDrivers for all major thermal printer brands on the NiceLabel 
CD and on the NiceLabel Web site. 

You can install a NiceDriver for your thermal printer in the following three 
ways: 

- Install within the NiceLabel software installation.  

- Use the Printer Installation Wizard. 

- Use the Windows Add Printer Wizard. 

Printer driver installation within NiceLabel software installation 

To continue installing the NiceDriver after setup has finished the NiceLabel 
software installation, do the following: 

1. Select the option Run Printer Installation Wizard. 
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2. Click on the Finish button. 

 
Installing NiceLabel driver for thermal printer 

3. Printer Installation Wizard will open. 

4. Select your printer from the list. Click on the Next button. 

5. Select the port where you have connected your printer and click on the 
Finish button. 

Note: This type of printer installation is available only when running 
installation from NiceLabel CD. 

Printer driver installation using the Printer Installation Wizard 

1. Put the NiceLabel CD in your CD-ROM drive. The main installation 
application should start automatically. If not, start Windows Explorer, 
browse to the CD and double click on the file START.EXE. 

2. Click on Installation. A new window will open showing all NiceLabel 
editions. 

3. Click on NiceDrivers. The printer installation wizard will start. 
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4. Select your printer from the list. Click on the Next button. 

 
Selecting thermal printer 

5. Select the port where you have connected your printer and click on the 
Finish button. 

Note: If you have downloaded the installation for NiceDriver from the 
NiceLabel Web site, run the downloaded .EXE file and follow 
the steps four (4) and five (5). 

Printer driver installation using the Windows Add Printer Wizard 

1. Open Control Panel from Settings option in Start menu. 

2. Open Printers (Printers and Faxes) and select Add a Printer. 

3. Follow the Add Printer Wizard prompts. The actual steps vary 
depending on the version of your Windows operating system. It is only 
important to click on the Have disk button in the step where you can 
select printer manufacturer and model. 

4. Put the NiceLabel CD in your CD-ROM drive (if not already done so) 
and browse to the folder \Drivers.  
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5. Select the folder of your printer name and click on Open/OK buttons to 
return to the Add Printer Wizard. You will see the list of all available 
printer models of the selected printer. 

6. Select your model, click on the Next button and finish the installation. 

Note: Windows 2000 and Windows XP might prompt you to cancel the 
installation process because NiceDrivers do not have the digital 
signature by Microsoft. It is safe to continue with the 
installation at this point. NiceDrivers have not been certified by 
Microsoft but have been subject of intensive pre-release testing 
and comply with Microsoft's demands for printer drivers. 

 
Windows XP warning for not digitally signed drivers 

2.3 Installing NiceLabel Network Software 
NiceLabel Network software consists of two parts: the server and the client. 

Note: NiceLabel Network does not run if server and client are 
connected over WAN, internet or similar long-distance 
connections. 

Before you install both parts you must provide full access permission to the 
folder on the server computer where you want to install the NiceLabel 
software. Then install the NiceLabel software on the server computer. 
Install the NiceLabel software (client) on the workstation next. Client 
installation is possible from the NiceLabel server or from the NiceLabel 
CD. 

Note: NiceLabel Express and NiceLabel Pro editions are not available 
with network licenses. Only NiceLabel Suite edition is available 
with network licensing. 
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2.3.1 Install NiceLabel Software on the Server 

Please follow these steps to install NiceLabel software on the server 
computer: 

1. Make sure that the folder on your server where you want to install the 
NiceLabel software provides full access admission. 

2. Put the NiceLabel CD in your CD-ROM drive. An installation window 
will open automatically. 

Note: If the installation wizard does not start automatically, go to the 
main CD directory of your NiceLabel CD and double-click on 
the file START.EXE. 

3. Click on Install. A new window will open showing all NiceLabel 
editions. 

4. Click on NiceLabel Network (Server). 

5. Follow the installation prompts. 

6. When prompted to Select Server Location, type in (or browse) the 
network location where you will install the server part of NiceLabel 
Network edition and click on Next.  

Note: Make sure to use UNC syntax when referring to the server 
location even if you install the server part on the local disk. Use 
the syntax \\server\share\file and not the syntax with the mapped 
drive like W:\share\file. 
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Selecting network path for NiceLabel server installation 

7. You could enter the location of the secondary server that will take over 
when primary server fails. If you have a computer to act as a secondary 
NiceLabel server, enter the UNC path to the appropriate folder. 

Note:  If unsure, leave the edit field empty. The secondary server is 
optional. 

8. Click on the Next button to finish the installation.  

Note: You should select a server and disk share that is visible to all 
workstations in the domain where you intend to use the 
NiceLabel software. 

2.3.2 Install NiceLabel Software on the Workstation 

There are two ways how you can install the NiceLabel Network client on 
the workstation: 
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- Installing the client from the CD. 
Install NiceLabel Suite single user software from the NiceLabel CD 
as described in the chapter Installing NiceLabel Software. 

- Installing the client from the network. 
Install NiceLabel client by running the installation file NiceLabel-
ProSuite5.exe from the NiceLabel server.  

Follow these steps to install the client from the network: 

1. Open Windows Explorer. 

2. Browse to the NiceLabel server computer in My Network Places. 

3. Browse to the folder where NiceLabel software is installed on the 
server. 

4. Double click on the file NiceLabel-ProSuite5.exe. 

5. Follow on-screen instructions. Just make sure to install NiceLabel 
Suite edition, not NiceLabel Pro. For detailed instructions you can 
also refer to the installation of the single user edition in the chapter 
Installing NiceLabel Software. 

Note: NiceLabel client installed on the workstation must have full 
access (read, write, delete) to the NiceLabel System subfolder on 
the server computer. 

6. Click on the Finish button to finish the installation. 

2.4 Activating NiceLabel Software 
The following activation instructions work for single-user and network 
NiceLabel editions. 

You have to activate the NiceLabel software if you want to use it. If you do 
not complete the activation process, NiceLabel will run in demo mode. 

The Product Activation utility will always run after installation. If you want 
to change the activation type or add more licenses to your network edition, 
you can also start activation from the NiceLabel software by opening the 
Manage License window under the Help menu.  

There are three types of NiceLabel software activation:  

• Hardware key activation 
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• Single-user Software key activation 

• Network Software key activation 

• Enterprise Print Manager license server 

Hardware key activation: NiceLabel software editions with hardware key 
can be used immediately after installation. If you have a NiceLabel edition 
with a hardware key, please skip ahead to the chapter Activate NiceLabel 
with a Hardware Key.  

Single-user Software key activation:  NiceLabel software editions with a 
single-user software key need to run the NiceLabel activation application in 
order to obtain full functionality. The Software Key number is a sequence 
of 25 characters.  

Network Software key activation:  You can activate the server part of the 
NiceLabel Network edition the same way as NiceLabel editions that come 
with a single-user software key. The Network Software Key number is a 
sequence of 25 characters. Activating the server part will also activate the 
client on the current workstation. If you upgrade the network edition with 
additional users, you have to install and activate each additional 
workstation separately. Please refer to the chapter Activate Additional 
Network Clients. 

Enterprise Print Manager license server: You can activate the NiceLabel 
client with the license coming from the Enterprise Print Manager (EPM). 
Enterprise Print Manager is available with the NiceLabel Enterprise Series 
edition NiceLabel Print Center. Before you can activate the client, you 
must activate the NiceLabel Print Center. 

2.4.1 Activate NiceLabel with a Hardware Key 

You can activate the NiceLabel single user editions (Express, Pro and 
Suite) with a parallel or USB key. However, you cannot activate the 
NiceLabel network edition with a hardware key!  

Make sure you have finished installing the NiceLabel software on your PC 
when you activate your NiceLabel single user edition with a hardware key. 
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Activate NiceLabel with a Parallel Key 

 
To activate NiceLabel using a parallel key, do the following: 

1. Shutdown your computer and switch off your printer. 

2. Connect the hardware key directly to the parallel port (marked as 
LPT or PRN port) on your computer. 

Make sure you connect the hardware key in such a manner that pins 
on the key plug into the holes in the computer port. Fasten the two 
screws to secure the key. 

Note: Do not remove the screws or try to turn them inside out. 

 Never try to connect the key to a serial port on the computer or 
directly to a printer. You can permanently damage the hardware 
key as well as your computer equipment. 

3. Start NiceLabel software. The Warning windows will open. 

4. Click on Manage License. The Manage License window will open. 

5. Select Activate the package and click on Next. 

6. Select Hardware Key and click on Next. A new Manage License 
window will open showing the key license information for your 
NiceLabel software. 

7. Click on the Finish button and NiceLabel will start in full working 
mode. 

Note: If you own a serial printer, you cannot connect the printer to the 
hardware key directly because the connectors are not compatible. 
Always connect your serial printer to the serial port and hardware 
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key to the parallel port. Your printer does not need to print 
"through" the hardware key. 

Activate NiceLabel with a USB Key 

 
 

To activate NiceLabel using a USB key, do the following: 

1. Plug the USB key into an available USB port. 

2. Start NiceLabel software. The Warning windows will open. 

3. Click on Manage License. The Manage License window will open. 

4. Select Activate the package and click on Next. 

5. Select Hardware Key and click on Next. A new Manage License 
window will open showing the key license information for your 
NiceLabel software. 

6. Click on the Finish button and NiceLabel will start in full working 
mode. 

2.4.2 Activate NiceLabel Single User Edition 

You can activate NiceLabel automatically through the Activation Server or 
manually through the activation Key Number Activation Web site. 
NiceLabel activation on the Web only works with single-user software key 
and network software key. If the computer that uses the NiceLabel software 
is not connected to the Internet, you will have to open the Activation Web 
page on a computer with Internet access to obtain the activation 
information. 
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Before you start the activation process of the NiceLabel software, get 
familiar with the following terminology: 

• Key number:  The sequence of 25 characters provided with the 
NiceLabel software. 

• Registration number:  Unique number generated during the 
activation process. The registration number validates the entered 
software key. 

• Activation code:  Issued on the NiceLabel activation Web site. The 
activation code activates the NiceLabel software on your computer. 

To activate the NiceLabel software, do the following: 

1. After the installation is complete, run NiceLabel software. The 
Warning window will open. 

2. Click on Manage License. The Manage License window will open. 

3. Select Activate the package and click on Next. 

 
Selecting 'Single-user Software Key' activation 

4. Select Single-user Software Key and click on Next.  
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5. Enter the required customer information and the key number.  

6. Click on the Next button. The window Manage License – Activation 
Code will open. 

 

 
Validating the key number 

7. To activate the software automatically, click on the link Connect to 
the Activation server (recommended).  

8. To activate the software manually, click on the Internet link for Web 
page activation. Your Internet browser will open the NiceLabel Key 
Number Activation Web site. 

a. Enter the key number and the registration number. Enter other 
user information, if prompted. 

b. Click on the Activate button to retrieve the Activation code. 

c. Copy the Activation code and paste it in the field Activation 
Code in the open Manage License – Activation code window 
of the open NiceLabel software. 
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Internet activation web site 

9. Click on the Next button and follow the prompts to complete the 
activation process. 

Note: You can still activate the NiceLabel software if the computer 
does not have access to the Internet.  

If the computer where you installed NiceLabel software does not have 
Internet access, do the following: 

1. Follow the steps one (1) to four (4) from the previous section. 

2. Write down the Key number and the Registration number. 

3. Write down the Internet activation Web address. 

4. Go to a computer with Internet access and open the activation Web 
site in the Internet Explorer. 

5. Enter the Key number and the Registration number. Enter other user 
information when prompted. 
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6. Click on the Activate button to retrieve the Activation code. Write it 
down. 

Note: The Key and Registration numbers, the Activation code and 
information in other fields are case-sensitive, so be careful when 
writing it down. 

7. Go back to the NiceLabel computer where the window Manage 
License is still open. 

8. Enter the Activation code. 

9. Click on the Next button and follow the prompts to complete the 
activation process. 

2.4.3 Activate NiceLabel Network Edition 

You can only activate the NiceLabel network edition with a 25-digit 
software key. The network edition does not provide the activation option 
with a parallel or USB hardware key. Before you start the activation 
process of the NiceLabel software, get familiar with the following 
terminology: 

• Key number: The sequence of 25 characters provided with the 
NiceLabel software. 

• Registration number: Unique number generated during the 
activation process. The registration number validates the entered 
software key. 

• Activation code: Issued on the NiceLabel activation Web site. The 
activation code activates the NiceLabel software on your computer. 

To activate the NiceLabel network software, do the following: 

1. After you have installed the server and client parts of the NiceLabel 
network edition, run the NiceLabel software from your server 
computer. No valid license is found. Click on the button Manage 
License.  

2. Select Network Software Key and click on Next.  
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Selecting 'Network Software Key' activation 

3. The primary network location path should be the same as the one 
entered at installation (see the chapter Install NiceLabel Software 
on the Server) and click on Next. 

Note: Make sure you are using UNC syntax when referring to the 
network location. Use the syntax \\server\share\file and not the 
syntax with the mapped drive like W:\share\file. 
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Entering Primary Network Location 

4. Enter the required customer information and the key number and 
click on Next.  

5. To activate the software automatically, click on the link Connect to 
the Activation server (recommended). 

6. To activate the software manually, click on the provided Internet link 
for Web page activation. Your Internet browser will open the 
NiceLabel Network Key Number Activation Web site. 

a. Enter the key number and the registration number. Enter other 
user information, if prompted. 

b. Click on the Activate button to retrieve the Activation code. 

c. Copy the Activation code and paste it in the field Activation 
Code in the open Manage License – Activation code window 
of the open NiceLabel software. 
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Validating the key number 

7. Click on the Next button and follow the prompts to complete the 
activation process. 

Note: You can still activate the NiceLabel software if the computer 
does not have access to the Internet.  

If the computer where you installed NiceLabel software does not have 
Internet access, do the following: 

1. Follow the steps one (1) to four (4) from the previous section. 

2. Write down the Key number and the Registration number. 

3. Write down the Internet activation Web address. 

4. Go to a computer with Internet access and open the activation Web 
site in the Internet Explorer. 

5. Enter the Key number and the Registration number. Enter other user 
information when prompted. 
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Internet activation web site 

6. Click on the Activate button to retrieve the Activation code. Write it 
down. 

Note: The Key and Registration numbers, the Activation code and 
information in other fields are case sensitive, so be careful when 
writing down the numbers. 

7. Go back to the NiceLabel computer where the window Manage 
License is still open. 

8. Enter the Activation code. 

9. Click on the Next button and follow the prompts to complete the 
activation process. 

2.4.4 Activate Software with License from Enterprise Print 
Manager 

Enterprise Print Manager (EPM) is a component of the NiceLabel Print 
Center edition. EPM stores the NiceLabel client licenses in its license 
server. 
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To activate the NiceLabel client with a license from EPM, do the 
following: 

1. After the installation of NiceLabel client is complete, run NiceLabel Pro. 
The Warning window will open. 

2. Click on Manage License. The Manage License window will open. 

3. Select Activate the package and click on Next. 
 

 
Selecting "Enteprise Print Manager license server" activation 

4. Select Enterprise Print Manager license server and click on Next. 

5. Enter the name of the Windows server where NiceLabel EPM is 
installed, click on Next. 

If the license from the EPM is successfully obtained, the NiceLabel client 
log settings will be changed to send all log information to a central location 
in the EPM. 

Note: When you use license from EPM, the log data can be stored only 
on the EPM, only in the local Access database, or combined on 



Chapter 2: Installation and Activation  

 

 

32 NiceLabel Quick Start Guide 

both locations. To change the log settings open Tools -> Options 
and make the change. 

If your NiceLabel Print Center is not already activated, no licenses are 
available in the EPM. Before you can activate NiceLabel clients with 
licenses from the EPM, you must activate the NiceLabel Print Center. Have 
your 25-character Activation Software Key ready and follow on-screen 
instructions or refer to the NiceLabel Print Center User Guide. 

2.4.5 Activate Additional Network Clients 

The Network client you have used for activation of the NiceLabel Network 
server is activated automatically. To activate additional NiceLabel Network 
clients on other workstations please follow these steps: 

1. Install NiceLabel Suite on the workstation. 

2. Open the NiceLabel software. No valid license is found and the 
window Manage License opens.  

3. Select Network Software Key and click on Next. 

 
Locating the NiceLabel Network licenses 
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4. Browse for the location where the NiceLabel Network was installed 
and click on the Next button. 
The license information will be copied from the server. 

Note: Make sure you are using UNC syntax when referring to the 
network location. Use the syntax \\server\share\file and not the 
syntax with the mapped drive like W:\share\file. 

The NiceLabel Network client is activated. The full NiceLabel version can 
only run on the workstation if the NiceLabel server has enough licenses 
available. If no license is available, you can only work with the NiceLabel 
Demo Mode and have to wait until one of the client currently running 
NiceLabel logs off. 

2.5 NiceLabel Demo Mode 
The demo mode is enabled when you do not activate NiceLabel after the 
installation. The demo mode of the NiceLabel software has limited 
functionality. The major limitations are: 

• You can only print five (5) labels per print job. 

• You can only define one (1) variable field on the label you want to 
export (to Pocket NiceLabel, to SAP, to printer's memory or using 
other export possibilities). 

• Random characters will replace the data values of label objects. 

• If you continue running NiceLabel software in the demo mode, you 
will experience increasing delay at startup. 

To change from demo mode to full functionality without limitations, you 
have to activate your NiceLabel software. 

2.6 Installing NiceLabel Upgrades 
You can upgrade the NiceLabel software in the following ways:  

• Upgrade software within one version (minor version upgrade), for 
example from 5.0.0 to 5.1.0. 

• Upgrade software version from an older version to the most current 
one (major version upgrade), for example 4.1.0 to 5.0.0. 
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• Upgrade software edition, for example NiceLabel Pro to a more 
advanced edition like NiceLabel Suite. 

2.6.1 Install NiceLabel Minor Version Upgrade 

In a NiceLabel software minor version upgrade, you upgrade an older 
minor version, for example NiceLabel 5.0.0, to the latest version of 5.x.x. 
Before you upgrade your NiceLabel software, make sure you 

- Backup your NiceLabel files. 

- Do not remove the existing version from your desktop PC. 

- Check what NiceLabel edition you have. 

Note: To check your NiceLabel edition, look at the label on your CD 
case or open the NiceLabel software and go to Help/About. 

To upgrade your NiceLabel stand-alone/ single user software (minor 
version upgrade), do the following: 

1. Close the NiceLabel software on your desktop PC. 

2. Disable your Virus Scan software. 

3. Install the new minor version in the same folder where the old 
version is currently installed. The new version will replace the old 
one. 

4. Follow the prompts. 

2.6.2 Install NiceLabel Major Version Upgrade 

In a NiceLabel software major version upgrade, you upgrade an older 
version, for example NiceLabel 4.x.x, to the latest version of 5.x.x. Before 
you upgrade NiceLabel software, make sure you 

- Backup your NiceLabel files. 

- Do not remove the existing version from your desktop PC. 

- Check what NiceLabel edition you have. 

Note: To check your NiceLabel edition, look at the label on your CD 
case or open NiceLabel software and go to Help/About in the 
menu. 
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To upgrade your NiceLabel stand-alone/ single user software (major 
version upgrade), do the following: 

1. Close NiceLabel and any other software on your desktop PC. 

2. Disable your Virus Scan software. 

Note: Make sure that all clients have logged off if you have Network 
edition. 

3. Put the NiceLabel CD in your CD-ROM drive. 

4. Install the same NiceLabel edition as you already have; for example, 
if you have NiceLabel Pro 4.1.x and want to upgrade to NiceLabel 
Pro 5.x.x, install NiceLabel Pro 5.x.x.  

5. Follow the prompts. 

2.6.3 Install NiceLabel Edition Upgrade 

When you perform an edition upgrade, you want to upgrade to a more 
powerful NiceLabel edition; for example upgrade from NiceLabel Express 
to NiceLabel Pro or NiceLabel Pro to NiceLabel Suite. Before you upgrade 
your NiceLabel software, make sure you  

• Backup your NiceLabel files. 

• Close NiceLabel and any other software on your desktop PC. 

• Do not remove the existing NiceLabel software edition. 

To upgrade your NiceLabel stand-alone/ single user software edition, do 
the following: 

1. Put the NiceLabel CD in your CD-ROM drive. 

2. Install the new edition (Pro or Suite) on your computer. Follow the 
same instructions as for first-time installation. Refer to the chapter 
Installing NiceLabel Software.  

3. Follow the prompts. 

Note: Activate the new edition of the NiceLabel software when you 
have received the activation document from your vendor with the 
upgrade package. You won’t be able to use the new edition until 
you have activated it. 
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2.7 Installing NiceLabel Network Upgrades 
You can upgrade the NiceLabel Network software in the following ways:  

• Upgrade software within one version (minor version upgrade), for 
example from 5.0.0 to 5.1.0. 

• Upgrade software version from an older version to the most current 
one (major version upgrade), for example 4.1.0 to 5.0.0. 

• Upgrade software from stand-alone edition (single user license) to a 
NiceLabel Suite Network edition with five or more concurrent users. 

2.7.1 Install NiceLabel Minor Version Network Upgrade 

In a NiceLabel minor version network upgrade, you upgrade an older minor 
version network, for example NiceLabel 5.0.0, to the latest version of 5.x.x. 
Before you upgrade your NiceLabel software, make sure you 

• Backup your NiceLabel files. 

• Do not remove the existing version from your server and 
workstations. 

Note: To check your current NiceLabel version, look at the label on 
your CD case or open the NiceLabel software and go to 
Help/About. 

To install a new minor version of NiceLabel on the server and on the 
workstations, do the following: 

1. Close NiceLabel and any other running software on your server and 
workstations. 

2. Disable your Virus Scan software. 

3. Put the NiceLabel CD in your CD-ROM drive on any computer with 
a NiceLabel client installed. 

Note: Make sure that all clients have logged off before you install the 
latest NiceLabel Network minor version upgrade. 

4. Install the new version on the server computer. Follow the same 
instructions as for the first-time installation. Refer to the chapter 
Install NiceLabel Software on the Server.  
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5. Install the new version on all workstations. Follow the same 
instructions as for first-time installation. Refer to the chapter Install 
NiceLabel Software on the Workstation. 

2.7.2 Install NiceLabel Major Version Network Upgrade 

In a NiceLabel major version network upgrade, you upgrade an older 
network version, for example NiceLabel 4.x.x, to the latest version of 5.x.x. 
Before you upgrade NiceLabel software, make sure you 

• Backup your NiceLabel files. 

• Leave the existing network version on your server and workstations. 

Note: To check your current NiceLabel version, look at the label on 
your CD case or open NiceLabel software and go to Help/About. 

To upgrade your NiceLabel software (major version upgrade), do the 
following: 

1. Close NiceLabel and any other running software on your server and 
workstations. 

2. Disable your Virus Scan software. 

Note: Make sure that all clients have logged off before you install the 
latest Network version. 

3. Install the new version on the server computer. Follow the same 
instructions as for the first-time installation. Refer to the chapter 
Install NiceLabel Software on the Server.  

4. Install the new version on all workstations. Follow the same 
instructions as for first-time installation. Refer to the chapter Install 
NiceLabel Software on the Workstation. 

2.7.3 Install NiceLabel Network Upgrade from Single User 
Edition 

When you perform a network upgrade from a single user edition, you want 
to upgrade for example from a NiceLabel Pro stand-alone/ single user 
edition to a NiceLabel Suite Network edition. Before you upgrade your 
NiceLabel software, make sure you  
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• Backup your NiceLabel files. 

• Remove the existing NiceLabel software edition from your desktop 
computer. 

To upgrade your NiceLabel software edition, do the following: 

1. Put the NiceLabel CD in your CD-ROM drive. 

2. Disable your Virus Scan software. 

3. Install the new network edition on the server computer. Follow the 
same instructions as for the first-time installation. Refer to the 
chapter Install NiceLabel Software on the Server.  

4. Install the new network edition on all workstations. Follow the same 
instructions as for first-time installation. Refer to the chapter Install 
NiceLabel Software on the Workstation. 

2.8 Activating NiceLabel Upgrades 

2.8.1 Activate NiceLabel Minor Version Upgrade 

When you upgrade to a new minor version of NiceLabel of the same 
edition, for example NiceLabel Pro version 5.x.1 to NiceLabel Pro version 
5.x.2, the software will remain activated. Just make sure you install the new 
version in the same folder as the existing version. Please follow the same 
instructions as described in the chapter Install NiceLabel Minor Version 
Upgrade.  

Note: For the network edition make sure to install the server part in 
the same folder on the server that is currently used for NiceLabel 
Network. You will not have to activate the NiceLabel server 
again. It will remain activated from the previously installed build. 

2.8.2 Activate NiceLabel Major Version Upgrade 

When you upgrade to a new major version of NiceLabel of the same 
edition, for example NiceLabel Pro version 4.1.x to NiceLabel Pro version 
5.x.x, you will have to activate the software again. The new version does 
not override the existing one and you can work with both the old and new 
NiceLabel version of the same edition. Please follow the same instructions 
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as for the first-time installation of NiceLabel in the chapter Installing 
NiceLabel Software. 

Summary of required steps: 

1. Close running NiceLabel applications. 

2. Do not remove the existing version of NiceLabel software. 

3. Install the new NiceLabel version of the same edition you already 
have. 

4. If your NiceLabel software (old version) has a hardware key (USB or 
Parallel, see chapter Activating NiceLabel Software), plug the key 
in your computer. 

5. Activate the new NiceLabel version with the upgrade key number. 

Note: To upgrade your NiceLabel software version 4.1.x to NiceLabel 
version 5.x.x, you need to have available both the old 25-digit 
serial number (for version 4.1.x) and the new 25-digit software 
key number (for version 5.x.x). Both keys are required to activate 
your NiceLabel upgrade.  

To activate the new NiceLabel version, do the following: 

1. Open the newly installed NiceLabel software version. A Warning 
window will open. 

2. Click on the Manage License button. The Manage License window 
will open.  

Note: If you activate NiceLabel immediately after completing the 
installation, select Activate the package and click on Next. 

3. Select Single User Software Key and click on Next. A new Manage 
License window will open showing the key license information of 
your old NiceLabel version. 

Note: If your old NiceLabel software came with a USB or Parallel key, 
plug the key into an available port, select Hardware Key and 
click on Next. 

4. If your NiceLabel software is protected by a software key, select 
Manage current software key license and click on Next. 
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If your NiceLabel software is protected by a hardware key, select 
Manage current hardware key license and click on Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Selecting ‘Manage current software key license’ 

Select ‘Manage 

current  

hardware key 

license’ 

5. In the Manage License – Manage software key license window, 
select Upgrade key license and click on Next. 

6. In the Manage License – Upgrade code window, enter the Upgrade 
Key Number you received from your vendor. 

7. To activate the software automatically, click on the link Connect to 
the Activation server (recommended). 

8. To activate the software manually, click on the provided Internet link 
for Web page activation. Your Internet browser will open the 
NiceLabel Upgrade Activation Web site. 

a. Enter user information and click on ACTIVATE. A new 
window will open with the generated Activation Code. 

b. Copy the Activation code from the Web site and paste it in the 
field Activation Code in the open Manage License – 
Activation code window of the open NiceLabel software. 
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Entering Upgrade Key Number 

 

9. Click on the Next button and follow the prompts to complete the 
activation process. 

Note: You can still activate the NiceLabel software if the computer 
does not have access to the Internet. Please refer to the chapter 
Activate NiceLabel Single User Edition. 

2.8.3 Activate NiceLabel Edition Upgrade 

When you upgrade to a new edition of NiceLabel software, for example 
from NiceLabel Express to NiceLabel Pro or NiceLabel Pro to NiceLabel 
Suite, you keep the existing NiceLabel edition on your computer and install 
and activate the new NiceLabel edition. Please follow the same instructions 
as for the first-time installation of NiceLabel in the chapter Installing 
NiceLabel Software. To activate the new NiceLabel software edition, 
follow the activation instructions discussed in the chapter Activating 
NiceLabel Major Version Upgrade. 

Note: To upgrade your NiceLabel software edition, you need to have 
available the old serial number/ software key and the new 25-
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digit software key number. Both keys are required to activate 
your NiceLabel upgrade. 

Summary of required steps: 

1. Close all NiceLabel applications. 

2. Install the new NiceLabel edition. 

3. Activate the new NiceLabel edition with the upgrade key number. 

2.8.4 Activate NiceLabel Network Major Version Upgrade 

In a NiceLabel major version network upgrade, you upgrade an older 
network version, for example NiceLabel 4.x.x, to the latest version of 5.x.x. 
Summary of required steps: 

1. Backup your NiceLabel files. 

2. Leave the existing network version on your server and workstations. 

Note: To check your current NiceLabel version, look at the label on 
your CD case or open NiceLabel software and go to Help/About. 

3. Install the new version on the server computer. Follow the same 
instructions as for the first-time installation. Refer to the chapter 
Install NiceLabel Software on the Server.  

4. Install the new version on all workstations. Follow the same 
instructions as for first-time installation. Refer to the chapter Install 
NiceLabel Software on the Workstation. 

5. Activate the new NiceLabel version with the upgrade key number. 

Note: To upgrade your NiceLabel Network version 4.1.x to NiceLabel 
Network version 5.x.x, you need to have available both the old 
25-digit serial number (for version 4.1.x) and the new 25-digit 
software key number (for version 5.x.x). Both keys are required 
to activate your NiceLabel upgrade.  

To activate the new NiceLabel Network version, do the following: 

1. Open the newly installed NiceLabel software version on your server 
or any client computer. A Warning window will open. 
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2. Click on the Manage License button. The Manage License window 
will open.  

Note: If you activate NiceLabel immediately after completing the 
installation, select Activate the package and click on Next. 

3. Select Network Software Key and click on Next. A new Manage 
License window will open showing the network installation location. 

4. Enter the primary network location path that should be the same as 
the one entered at installation (see the chapter Install NiceLabel 
Software on the Server) and click on Next. 

Note: Make sure you are using UNC syntax when referring to the 
network location. Use the syntax \\server\share\file and not the 
syntax with the mapped drive like W:\share\file. 

 
Entering Primary Network Location 

5. Enter the required customer information and the upgrade key number 
and click on Next.  
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6. To activate the software automatically, click on the link Connect to 
the Activation server (recommended). 

7. To activate the software manually, click on the provided Internet link 
for Web page activation. Your Internet browser will open the 
NiceLabel Upgrade Activation Web site. 

a. Enter the key number and the registration number. Enter other 
user information, if prompted. 

b. Click on the Activate button to retrieve the Activation code. 

c. Copy the Activation code and paste it in the field Activation 
Code in the open Manage License – Enter Old Key Number 
window of the open NiceLabel software. 

 
Validating the key number 

8. Click on the Next button and follow the prompts to complete the 
activation process. 
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Note: You can still activate the NiceLabel software if the computer 
does not have access to the Internet. Please refer to the chapter 
Activate NiceLabel Network Edition. 

2.8.5 Activate NiceLabel Network Upgrade from Single User 
Edition 

When you upgrade to a NiceLabel Network edition from a single user 
edition, for example NiceLabel Pro stand-alone/ single user edition to a 
NiceLabel Suite Network edition, you must remove the old stand-alone 
edition and install the new network edition on the server computer and on 
all workstations. Follow the same instructions as for the first-time 
installation. Refer to the chapters Install NiceLabel Software on the 
Server and Install NiceLabel Software on the Workstation.  

To activate the new NiceLabel Network edition, follow the activation 
instructions discussed in the chapters Activating NiceLabel Network 
Edition and Activating Additional Network Workstations. 

Summary of required steps: 

1. Backup your NiceLabel files. 

2. Remove the existing NiceLabel software edition from your desktop 
computer.  

3. Install the NiceLabel Network software on your server and on the 
workstations. 

Note: Make sure that all clients have logged off before you install the 
NiceLabel Network edition. 

4. Activate the new NiceLabel Network edition (server and client 
activation) with the new network key number. 

2.8.6 Activate NiceLabel Network License Pack 

With a NiceLabel Network License Pack upgrade you can add user licenses 
to your current NiceLabel Network edition in increments of 5, 10, 20 or 50 
concurrent users. To add additional network user licenses, you only have to 
activate your network edition with the NiceLabel Network License Pack 
software key you have received from your vendor. 



Chapter 2: Installation and Activation  

 

 

46 NiceLabel Quick Start Guide 

To upgrade your NiceLabel Network edition with additional user licenses, 
do the following: 

1. Open the NiceLabel software on your server computer or any client 
that has installed the NiceLabel software. 

2. Click on the Manage License button. The Manage License window 
will open.  

3. Select Manage current software key license and click on Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Selecting ‘Manage current network license’ 

Select ‘Manage 

current network 

license’ 

 

4. In the Manage License – Manage Network License window, select 
Add network license and click on Next. 
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 Selecting ’Add network licenses’ 

5. In the Manage License – License Pack Key Number window, enter 
the License Pack Key Number you received from your vendor. 

6. To activate the software automatically, click on the link Connect to 
the Activation server (recommended). 

7. To activate the software manually, click on the provided Internet link 
for Web page activation. Your Internet browser will open the 
NiceLabel License Pack Activation Web site. 

a. Enter user information and click on ACTIVATE. A new 
window will open with the generated Activation Code. 

b. Copy the Activation code from the Web site and paste it in the 
field Activation Code in the open Manage License – Manage 
Network License window of the open NiceLabel software. 

8. Click on the Next button and follow the prompts to complete the 
activation process. 
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Note: You can still activate the NiceLabel software if the computer 
does not have access to the Internet. Please refer to the chapter 
Activate NiceLabel Network Edition. 

2.9 Registering NiceLabel Software 
At the end of the activation process, please fill out the registration form in 
the last step of the Product Activation process. 

Registration is not required to enjoy the full working mode of the 
NiceLabel software. However, you should register the NiceLabel software 
to receive the following benefits: 

- Free access to NiceLabel downloads and updates. 

- Free Technical Newsletter discussing product news. 

- Fast technical support. 

 

2.10 Uninstalling NiceLabel software 
To uninstall the software, open Add or Remove Programs in the Control 
Panel. Select the NiceLabel program in the list, and click on Remove. The 
NiceLabel software will be uninstalled, and you may need to use the same 
procedure to remove some of the standalone NiceLabel components. 

Note:  If you are using 2000, XP, 2003 or Vista, you have to log on as a 
user with administrator rights to be able to perform the 
uninstallation. 

2.10.1 Software license key deactivation 

During the uninstall procedure, you will be prompted, if you would like to 
deactivate your software license.  

If you wish to deactivate your software license without uninstalling the 
software, follow these steps: 

1. In the Help menu, click on Manage License and open the License 
Manager. 
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2. Check the Manage current software key license box, and click on 
Next. 

3. Select Deactivate License and click on Next 

An internet connection is required in order to connect to the activation 
server. 

Note:  This license activation will be removed from the activation 
server, which allows you to use the same software key to activate 
the software on another computer when you install the software 
again. 

2.10.2 Hardware license key deactivation 

There is no need to deactivate the hardware license key. The license is 
stored in the hardware key itself, so you can transfer the license to another 
computer simply by moving the hardware key. 

2.10.3 NiceLabel Network license key deactivation 

The NiceLabel Network software manages its license automatically. It 
retrieves the license off the server when the program is started, and returns 
the license when it is closed. If you wish to move the software to another 
computer, license deactivation is not needed, and you can simply remove 
the software and install it on another computer. 

A license deactivation in NiceLabel Network applies to the server part of 
the software, and should only be used if you wish to move it to a new 
server. 
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3. Label Design and Printing 

In this chapter you will learn how to design and print labels with NiceLabel 
Pro. All examples assume that you use a thermal printer and a NiceDriver. 

The screenshots in this chapter show the default view on the NiceLabel 
user interface. You can change the interface according to your preferences. 
Basic mode will show only essential option in the dialog boxes and 
Advanced mode will make all program functionality available. You can 
switch between modes on-the-fly by clicking on the buttons 'Basic' and 
'Advanced' in the dialog boxes or set the default mode in the NiceLabel 
preferences. 

To start designing a label, open NiceLabel Pro. The figure below shows the 
default working interface of NiceLabel Pro. 

 

 

 Standard Toolbar 

 

 

 
NiceLabel working window 

Text Toolbar 

Alignment 
Toolbox 

Design area 

Order 



 Chapter 3: Label Design and Printing 

 

 

NiceLabel Quick Start Guide 51 

3.1 Designing a Basic Label 
In this section you will learn how to design a simple label file with fixed 
and variable objects. The variable objects can obtain values from several 
sources. You will learn how to: 

a. Provide object values with a keyboard prompt. 

b. Obtain object values from a database.  

c. Preview the label on the screen. 

d. Print the label. 

The label you create will look like this: 

 
Basic label 

3.1.1 Create a Basic Label 

To create a basic label, do the following: 

1. Open NiceLabel software (Pro or Express). 

2. Select New label in the File menu or click on the icon  in the 
standard toolbar. 
Each time you create a new label, a Label Setup Wizard will start to 
help you setup the label and connect to the printer. 

Note: You can leave the Wizard at any time and accept the default 
settings for the label by clicking on the Finish button. 
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Select a Printer 

1. Select the printer you want to use for label printing. 

Note: If you don’t find your printer on the list, refer to chapter Install 
Printer Driver for installation instructions. 

 
Selecting a printer 

2. Click on the Next button.  

Define Label and Page Dimensions  

1. If you want to use the label stock, select your choices in the window 
Select Stock.  

2. Click on the Next button. A new window will open to define the 
label dimensions manually. 

3. Leave the option Page Size on 'User defined' default and check 
Automatic Sizing.  

4. Click the Next button. A new window will open. 
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5. Select label orientation and print direction.  

 
Selecting label layout 

6. Click on the Next button. A new window will open. 
Enter 10 for label width and 7 for label height. 

Note: Dialog box differs from thermal and office printers.  
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Defining label dimensions 

Note: To change the unit of measure from centimeters to inches or 
other supported units, click on the button with unit of measure 
below the label preview in the dialog box. 

7. Click on the Finish button. New empty label will open. 

Enter Non-Changing Text 

1. Click on the  button in the Toolbox. The text cursor 
appears on the screen. 

 
Cursor for text object 
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2. Move the cursor to the location on the label where you want to place 
the text object and click on the mouse button.  

The dialog box with object properties will open. 

3. Enter the text "SAMPLE" and click on the Finish button. 

 
Entering content for text object 

4. Click on the text object to select the object. 

5. Change the font for the text object using the Text toolbar. 

Choose Arial font, 28 point size and bold style. 

 
Using format options in the text toolbox 
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6. To change the position and size of the text object, select the text 
object and drag object with your mouse to the position where you 
want to have it. 

The screen should show the following: 

 
The text object is placed on the label 

Insert Bar Code 

Now you will add a non-changeable Code128 bar code on the label. 

1. To insert the bar code, click on the  button in the 
Toolbox. 

2. Move the cursor to the desired position on the label and click on the 
mouse button.  

3. The dialog box with object properties will open. 

4. Enter the value 1234567890 for the bar code contents. 

5. Click on the Define button. 
Edit Bar Code dialog box opens. 

6. Make sure you select bar code Code128 and click on the OK button. 
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Selecting bar code type 

7. Click on the Finish button to return to the label. 

8. Change the position of the bar code by selecting the bar code and 
dragging it to the desired position. 

9. Change the object size by dragging the object handles. The handles 
are small rectangles surrounding the object when it is selected. 

The label should now show the following: 

 
Label with text and bar code objects 
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Insert Picture 

The NiceLabel software works with BMP, PCX, GIF, WMF, JPEG and 
many other popular graphic formats. 

1. To insert the picture, click on the  button in the 
Toolbox. 

2. Move the cursor to the desired position on the label and click on the 
mouse button. 

3. The Open dialog box will open allowing you to browse for your 
picture on your hard drive. Go to the folder Sample Graphics and 
select the picture LEISURE.WMF. Click on the Open button. 

The screen should show the following: 

 
Label with text, bar code and picture objects 

Use Drawing Tools 

Now you will insert a line to separate a text object from other objects and a 
rectangle around the picture object. 

1. Select the  icon from Toolbox and move the cursor to 
the required starting point of the line. 

2. Press and hold down the mouse button while drawing the line. Move 
the mouse to the end position of the line and release the button. The 
Line object is placed on the label. 
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3. Click on the  icon in the Toolbox and point the mouse 
to the upper left corner of the picture. 

4. Click and hold the mouse button while you stretch the rectangle to 
the lower right corner of the picture. 

5. To change the thickness of the vertical and horizontal line, double-
click on the rectangle object to open its properties. Select the 
thickness you want and click on the Finish button. 

6. To edit the drawing object, double-click on the line or rectangle to 
open the dialog box with its properties. 

The label should show the following: 

 

Drag object 
handles to 
change object 
size. 

Label with fixed objects 

Use Alignment Tools 

You have placed the objects on the label. Now you want to make sure they 
are aligned on the horizontal center of the label. You can align objects on 
the label by using the Align toolbar on the right side of the working 
window. 

To align objects on the label, do the following: 

1. Select all objects on the label. 

Note: The first object you select determines the alignment orientation 
for all selected objects. 
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2. Choose a select arrow in the Toolbox and draw a frame around all 
objects to select all objects. 

 
Selecting the objects on the label 

3. In the Align toolbar on the right, click on the icon  to arrange the 
objects. 
The selected objects will be rearranged and positioned on the 
horizontal center on the label. 

Note: There are also other alignment commands available in the Align 
Toolbar. 

 

Note: You can also align the objects to the label grid. The option Snap 
to Grid is available in the View menu. 

Save a Label 

Always save your label during the design process. To save a label, do the 
following:  

1. Select the  icon. 

2. Type in the name of the label. For example, enter 'label' for the name 
of the label. 

3. The name of the label is visible in the program caption. 

 
Name of the label in the program caption 
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Preview and Print a Label 

If you want to print a label, you can use the print preview to simulate a 
print output. The label preview shows the label on the screen. 

Simulate printing 10 labels on the screen to check label layout and printing 
procedure. 

1. Click on  icon in the Standard toolbar or select the 
command Print in the File menu. The Print dialog box appears. 

 
Print / print preview dialog box 

2. Enter 10 for Label Quantity and click on the Preview button. 
NiceLabel software will close the dialog box and simulate the 
production for 10 labels on the screen. 

Note: You can select between the quantity of the labels and the quantity 
of the pages. The page can have one or more labels and the labels 
are arranged on the page in columns and rows. If you have eight 
labels on the page, the quantity of ten pages will print 80 labels. 

When you are certain that the labels will be printed correctly and the 
preview shows the correct values, you can proceed to real printing. To 
actually print the labels, do the following: 

1. Click on  icon in the Standard toolbar. The Print dialog box 
appears. 
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2. Enter 10 for the Label Quantity and click on the Print button. Your 
printer will now print 10 labels. 

Note: To manage fast and easy label printing, you can print labels from 
the application NicePrint or the form generated with NiceForm. 
For more information refer to the chapter Other NiceLabel 
Applications. 

3.1.2 Add Variable Fields to a Label 

You may want to print the label on which the data changes for each label. 
NiceLabel software offers different variable fields (counters, date/time 
fields, operator's input from the keyboard) that you can use with text, 
graphics and bar code objects. 

For this example a new label was created. The following steps explain how 
to create a label that contains a prompted field, a counter and date/time 
fields. The captions in the following screenshots were added separately. 

   
The left label shows design mode, the right two labels are two consecutive labels from print preview 

Create Keyboard Entry Variable Fields 

The content of a prompted field can be different for every print job. Before 
you print the label, you enter the value for the field. 

1. Click on the small arrow next to the  icon in the 
Toolbox to display a list of available variable types. 

2. Select New Keyboard Input from the list and click on the label 
where you want to position the object. 
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A dialog box with the Variable Wizard will open. 

 
Creating new keyboard input variable field 

3. Type 'Enter product name' for the option Display this text to the print 
operator. 

4. Click on the Finish button. The cursor changes its shape to an arrow 
with a text object.  

5. Click on the label where you want to position the prompted field. 
The text object is placed on the label and linked to the new variable. 

Note: When you print the label, you will be prompted to enter the 
product name, which will be shown in preview on the label and 
on the printed label. 

Create Serialized Data Variable Fields 

Now create a counter field on the label. The value of that variable field will 
automatically increase by one on every label. 

1. Click on the small arrow next to the  icon in the 
Toolbox to display a list of available variable types. 

2. Select New Counter from the list. 

3. A dialog box with counter properties opens. 
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Creating new counter variable field 

4. Leave everything as default so that the counter will always start from 
1 and increase by one on each label.  

5. Click on the Finish button. 

6. Click on the label where the counter should be placed. 
The new variable is linked to the text object on the label. 

Note: Typically, the counter will increase by 1 on each label. For 
example, 1, 2, 3, 4, 5, etc. You can also define different 
incremental steps. 

Create Date and Time Variable Fields 

Content of the variable field can be filled automatically with the date or 
time stamp from the computer clock or printer clock (for supported printer 
models). 

1. Click on the small arrow next to the  icon in the 
Toolbox to display a list of available variable types. 

2. Select New Date Field from the list. A dialog box with date 
properties opens. 

 
Creating new date variable field 



 Chapter 3: Label Design and Printing 

 

 

NiceLabel Quick Start Guide 65 

3. Leave everything as default and the date will be used on the label 
using the format as defined in your Windows operating system. 

To place a time stamp on the label, do the following: 

1. Click on the small arrow next to the  icon in the 
Toolbox to display a list of available variable types. 

2. Select New Time Field from the list.  

3. Click on the Finish button. 

4. Click on the label where the time field should be placed. 

The new variable is linked to the text object on the label. 

The date and time fields are updated when you preview or print the label. 
In this example the values will come from the system clock of your 
computer. 

Use Prefix or Suffix Options 

You can add a prefix and suffix to each variable field on the label. Both are 
added to the value when you preview and print the label. 

1. Click on the small arrow next to the  icon in the 
Toolbox to display a list of available variable types. 

2. Select New Keyboard Input from the list.  

3. A dialog box with variable properties will open. 

4. Type the text 'Enter product weight' for the option Display this text to 
the print operator. Set the allowable characters to digits and click on 
the Next button. 

5. Enter ' kg' for the Suffix option. 

 
Defining the variable suffix 

6. Click on the Finish button. 

7. Click on the label where you want to position the prompted field. 
The text object is placed on the label and linked to the new variable. 
When you will preview or print the label, the suffix ' kg' will be 
appended to the entered value on the right side. 
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3.1.3 Change Common Printer Settings 

When you start designing a label you tell NiceLabel software to what 
printer the label should be connected. Each label file remembers the printer 
settings for the selected printer driver on the label. 

As an example, you will change the printing speed and darkness. To change 
the printer settings, do the following: 

1. Go to File – Printer Settings. The window with the printer settings 
will open. 

2. Open the Options tab. 

3. Change the Speed and Darkness options.  

4. Click on the OK button. 

5. Save the label by clicking the  button in the Standard toolbar or 
selecting the command Save in the File menu. 

 
Printer driver properties 

Note: Any changes in the printer settings dialog box will be saved to 
the label and applied to future print actions. 

You can also change the printer settings right before the label is printed. 

1. Select the Print option in the File menu. 

2. Go to the Printer tab. 
This tab allows you to change the printer just before printing begins, 
but it also enables you to change common printer settings like speed, 
darkness and print direction. 

Note: Changes to the settings in the Printer tab will not be saved in the 
label but used only at print time. 
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3.2 Linking a Label to Text Databases 
Text databases are text files containing data values that can be used for 
variable objects on the label. The text database is not a real database. It 
contains the data values but lacks the information of the data structure, 
name of the fields and maximum lengths of the fields. You have to provide 
the missing information before NiceLabel software can use the data from 
such a text database. 

  

  

  
The label in design mode (on the left) and preview of the five labels with data from the database 

3.2.1 Connect to a Database 

NiceLabel software offers a Database Wizard that guides you through the 
necessary steps to connect the database to a label. To connect your label to 
a database using the Database Wizard, do the following: 

1. Click on the  button in the Standard Toolbar. 

2. Click on the Browse button and point to the text database 
"C:\Program Files\EuroPlus\NiceLabel4\Samples\Database\data.txt".  
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Selecting the text database 

3. Click on the Next button. 

Note: If you connect to the database for the first time, you need to 
define the database structure. Continue with the next section. 

3.2.2 Format the Data with the Text File Wizard 

Because the text files do not contain the structural information like real 
databases do, you must define the fields and their data structure. When you 
use the same text database some other time, you won't have to define the 
structure again. 

1. Choose the data type for the selected text database. The fields are 
aligned in columns, so you must select the option Fixed.  
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Defining the type of the text database 

2. Click on the Next button. 

3. Define the widths of the individual columns by placing a break line 
before the second column and before the third column. 

 

 
Defining the fields in the text database 

4. Click on the Next button. 

5. Accept the default field names and click on the Next button. 
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6. Review the text database structure. The field names and their 
maximum lengths are displayed. Click on the Finish button to close 
Text File Wizard. 

The link to the database has been created and database fields are 
available on the label.  

NiceLabel software brings you back to the Database Wizard. 

3.2.3 Place Database Fields on a Label 

The next step in the Database Wizard opens the dialog box with the list of 
available fields from the database.  

1. By default all fields from the database will be used on the label. 
Click on the Next button. 

 
Using all fields in the text database 

2. Specify what records and how many you want to print: 
 
Select the options I want to select which record to print and I will 
enter label quantity for each selected record. Before printing 
labels, the table with the records will open and you will be able to 
select the records you want to print and the quantity of labels for 
each record. 
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Specifying which records from the database will be printed and in what quantity 

3. Click on the Next button. 

4. Select if the Database Wizard should link all selected fields from the 
database to the text objects on the label or if you want to link the 
fields manually to the label.  

5. Click on the Next button.  

6. Select I want a text object for each selected field and click on the 
Finish button. 

 
Each field from the database will be linked to a text object 

The label will show several text objects. Every field from the database is 
linked with the text object on the label.  

3.2.4 Use Print Preview to Select Data and View a Label 

Now you will simulate label printing using print preview. 

1. Click on the print icon  in the Standard Toolbar. 

2. The Print dialog box opens with the Quantity of labels set to 
Variable quantity (entered for each database record). This setting 
corresponds to your selection in the Database Wizard when you have 
selected the options I want to select which record to print and I 
will enter label quantity for each selected record. 
 
Only the records you select will be printed in the defined quantity. 
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Print / Print preview dialog box 

3. To choose which records to print from the database click on the 
Select Records button. The Record Selection dialog box will open. 

4. Select the records from the database you want to print and enter the 
number of labels you want to print for each selected record. 

 
Record selection dialog box 

5. Click on the OK button. You will return to the Print dialog box. 
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6. Click on the Preview button. Now you can preview the labels on the 
screen. Note that the text objects on the label change for each new 
record. 

 
Preview of the second label in the series 

7. Click on the Next button in the command window to advance to the 
next label in the series. After you see the last label in the preview 
series, NiceLabel software will re-open the Print dialog box. 

8. Click on the Close button to close the Print dialog box. 

3.2.5 Print a Label 

When you are certain that the label design is correct and label preview 
shows the correct values from the database, you can start sending the labels 
to the printer. To print a label, do the following: 

1. Click on the print icon  in the Standard Toolbar. 
The Print dialog box will open (same as the print preview dialog 
box). 

2. Click on the button Select Records and select the records you want 
to print and specify the label quantity for each record.  
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Selecting records and specifying label quantity 

3. Click on the OK button. 

4. Click on the Print button to start printing labels. 

5. Click on the Close button to close the dialog box. 

3.3 Designing an Advanced Label 
In this section you will learn how to design a label with advanced features. 
You will learn how to create a label using: 

a. GS1-128 bar code. 

b. Links to advanced databases.  

c. Advanced objects and functions. 

3.3.1 Create a Label with GS1-128 Compliance 

GS1-128 compliant bar codes are often used for encoding data into the bar 
code. NiceLabel software provides an GS1-128 Bar Code Wizard that helps 
you merge the data components (Application Identifiers) into the final bar 
code. 
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Edit Bar Code GS1-128 

 
The designed label with GS1-128 bar code 

To define the GS1-128 bar code, you first select this bar code type and 
assign a value to it. 

1. Click on the small arrow button next to the  button in 
the Toolbox. 

2. Select Fixed Bar Code in the context menu. 

 
Creating a fixed bar code 

3. Move the cursor to the location on the label where you want to place 
the text object and click on the mouse button.  

4. The wizard with object properties will open. 

5. Click on the button Define. The dialog box Edit Bar Code will open. 

6. Expand the group EAN.UPC and select the bar code GS1-128. 

7. Click on OK button to go back to the Bar Code dialog box. 

8. Click on the Next button. 
The GS1-128 Wizard will open. 

Add Content to GS1-128 Using GS1-128 Wizard 

Use the GS1-128 Wizard to help you add the necessary Application 
Identifiers (AI) in the bar code. Complete the following steps with the 
wizard: 
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1. Select 10 Batch or Lot number.  

 
Selecting Application Identifier from the list

2. Click on the Next button. 

3. Select Fixed and click on the Next button. 

4. Enter the sample data, for example '12345'. 

5. Click on the Next button. A dialog box showing all AI contained in 
this bar code will open. 

6. Click on the Add button to start adding a new AI. 
For example, select AI 21 (Serial Number). Repeat steps from 1 to 5 
above. 
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Two Application Identifiers are defined 

7. When you are satisfied with the designed AI and their positions 
within the bar code, click on the Finish button. 
The GS1-128 bar code is placed on the label. 

3.3.2 Link a Label to Advanced Databases 

You can use the NiceLabel software to retrieve data from any database on 
your computer or network. If you have the appropriate database drivers, 
you can connect to the database and use the records on the label. 

Note: NiceLabel Express does not have all database options available. 
You can only use data from text databases and Excel 
spreadsheets in NiceLabel Express. 

With NiceLabel software you can connect to any database type as long as 
you have the appropriate database drivers installed on your computer. 
NiceLabel supports different database drivers like ODBC, OLE DB and 
BDE. Your computer comes pre-installed with database drivers for 
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frequently used database types, but you can always install additional 
drivers. 

You have total control over which records in the database table will be 
printed. By default all records are printed, but you also have the option to 
select the records for printing. Before the labels are processed you can 
select the records in the table that you want to print. You can also specify 
the print quantity for each record. 

Advanced record selection techniques are also available in NiceLabel 
software. You can create database filters and obtain only the records that 
match the conditions. The same functionality allows you to join two or 
more database tables together and obtain values for the same product from 
multiple databases. 

Manual modification of the SQL sentence is available for advanced users. 

Note: For more information about linking to the advanced databases 
please refer to the User Guide or help file. 

3.3.3 Using Advanced Objects and Functions in NiceLabel 

The options described in this chapter are NOT available for the NiceLabel 
Express edition. 

Create Text Box Object 

The Text Box object enables you to use free-flow text inside the designed 
Text Box frame without being limited to a one-line text. To create a Text 
Box object, do the following: 

1. Click on the  button in the Toolbox. The text box 
cursor appears on the screen.  

2. Move the cursor to the location on the label where you want to place 
the text box object and click on the mouse button. The properties of 
the object will open.  

3. Open the Value tab and type in the text content. 
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Entering value for Text Box object 

4. Click on the OK button. The Text Box object is placed on the label. 

5. Double click the Text Box to open its properties.  

6. Go to the Detailed tab and select the option Best fit. 

Note: When you change the size of the Text Box frame, the content 
will automatically align to the new size. 

 
All three text objects are available in NiceLabel software 
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Create Rich Text Box (RTF) Object 

The Rich Text Box object enables you to format text in any kind of font 
types and styles. To create a Rich Text Box object, do the following: 

1. Click on the  button in the Toolbox. The rich text box 
cursor appears on the screen.  

2. Move the cursor to the location on the label where you want to place 
the text box object and click on the mouse button. The rich text 
editor will open.  

3. Enter the content.  

4. Use the text toolbar in the editor to format the characters. 

5. Click on the OK button. The Rich Text Box object is placed on the 
label. 

6. Double click the Rich Text Box to open its properties.  

7. Go to the Detailed tab and select the option Best fit. 

8. Click on the OK button. 
The text size in the Rich Text Box object automatically changes 
when you resize it. 

Use Functions to Manipulate Label Data 

NiceLabel software enables you to work with variable values on the label, 
manipulate the values and use them with other label objects. NiceLabel 
software offers a group of functions that help you work with the variable 
values. There is always some input to the function that the function 
manipulates and always some output that is stored to a function-generated 
variable. The function-generated variable can be linked to label objects or 
used in other functions. 

There are many NiceLabel functions available, such as Concatenate (for 
linked fields), Subset, Date addition, FACT, HIBC and Visual Basic script. 
Visual Basic script is a powerful function allowing you to perform 
advanced data manipulation. 

Note: For more information about NiceLabel functions please refer to 
the User Guide or help file. 
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Control Cutter in the Printer 

If you have a thermal printer equipped with the cutter, you can control the 
cutter action from NiceLabel software. You must use NiceDriver for your 
thermal printer if you want to control the installed cutter. To set up the 
cutter control, do the following: 

1. Select the option Label Setup in the File menu. 

2. Go to the Cutter Settings tab. 

3. Select the option Enable cutter. 

 
Enabling cutter functionality 

Note: NiceLabel Express edition can control the cutter. However, you 
cannot use the Label Setup dialog box. Instead you must define 
the cutter parameters in the properties of the NiceDriver printer 
driver. Please refer to the online help for instructions how to set 
up cutter in NiceLabel Express. 
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3.4 Designing an RFID Smart Label 
Radio frequency identification (RFID) refers to technologies that use radio 
waves to automatically identify individual or groups of items. NiceLabel 
software and NiceDrivers support programming and printing of RFID tags 
embedded in a label.  

Note: You can use RFID functionality in NiceLabel software only if 
you have installed a NiceDriver with RFID support. Make sure 
you install the NiceDriver of your RFID printer before you 
design and print an RFID smart label. 

3.4.1 Create RFID Smart Label 

1. Click on  button in the Standard toolbar. Label Setup Wizard 
will start. 

2. Select the printer that supports RFID smart label printing.  

3. Click on the Finish button. 
You will see that ‘RFID Tag’ command is enabled in the Toolbox on 
the left side of the NiceLabel software working window. 

 
RFID Tag is available for use 

3.4.2 Encode RFID Tag 

The RFID tags embedded into the label are usually of two types: ISO tags, 
which encode blocks of data; or UHF tags, which can encode one string of 
data. 
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1. Click on the button  in the Toolbox to begin encoding 
the data. The RFID Tag dialog box opens. 

 
Encoding contents for RFID Tag 

2. Select the type of the RFID Tag you want to use from the list box on 
the top of the dialog box. 

3. Make sure the option Write data to RFID tag is enabled.  

Note: If you don’t select this option, the definition of tag content is 
saved but is not sent to the printer during label printing. 

4. Go to the first available block in the section Data Blocks and click 
on the Data cell in the table.  

Note: You might not see the table-like structure. Instead you can see 
edit fields to enter the RFID data. The type of data entering 
depends on the type of selected RFID tag. 

5. Type in the value you want to encode into this block. Repeat the 
process for other blocks. 

6. Click on the OK button. A schematic view of the RFID Tag antenna 
will open in the label background identifying the definition of the 
RFID data on the label. 
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RFID Tag antenna in the background 

7. You can continue designing the smart label with non-RFID data as 
described in the previous sections. 

Whenever you print the label, the RFID data will be sent to the printer. The 
printer prints the RFID smart label and programs the RFID tag embedded 
into the label at the same. 

Note: NiceLabel can work with Unique RFID Tag numbers. Each 
RFID tag has embedded a unique serial number. Some printers 
can read the Unique RFID Tag number that can be used on the 
label linked with some label objects, like text and bar codes. 

 



 Chapter 4: Other NiceLabel Applications 

 

 

NiceLabel Quick Start Guide 85 

4. Other NiceLabel Applications 

NiceLabel software provides much more than just label design and 
printing. In the following chapter you will learn how to 

• Simplify label printing by using forms: Forms run as a 
standalone application and are modified to meet user 
requirements.  

• Manage label printing by using NicePrint: Select all print 
features in one window. 

• Use automatic label printing by using NiceWatch: NiceLabel 
integration middleware module adds label printing to any 
existing application.  

• Store frequently used label elements on a printer for faster 
label printout or usage from other applications. 

You need the NiceLabel Suite edition for most of the advanced tasks 
discussed in this chapter. 

 

4.1 Label Printing Using Custom Forms 
NiceForm is a front-end application generator available in the NiceLabel 
Suite edition. You can create your own custom designed data-entry 
application without programming skills. The main purpose of using forms 
is easy-to-use and error-free label printing for the operator. 

The following figure shows the label file that includes prompted fields, 
variable picture and bar code object. The form file is always generated 
from the label file. Before you can create a form you have to create a label 
with NiceLabel Pro. The label file provides simple access to all necessary 
information and commands.  

On the form, you can select the record from the table at the bottom. You 
can also use a printer selection drop-down menu and a button to print label 
with pre-defined quantity. 
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The label (on the left) is the basis for the form (on the right). 

4.1.1 Create a Form 

The New Form Wizard helps you create a form easily and connects to the 
label, obtains variables from the label and generates the form file. Your 
label must be designed before you can define a form. To create a form, do 
the following: 

1. Open NiceForm. 

2. Click on the button  to start the New Form Wizard or go to the 
File menu and select the command New/ New Form Wizard. The 
New Form Wizard will open.  

3. Read the summary and click on the Next button. 

4. Select Standard Windows desktop application for the type of the 
platform. Click on the Next button. 

5. Click on the  button and browse to the sample label 
LABEL2.LBL.  

6. Enable the option Place preview object on the form and click on 
the Next button. 
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Selecting the label file in New Form Wizard 

7. Select Use default template upon which the generated form will be 
created and click on the Next button. A new window will open. 

8. Select Vertical arrangement of the object and click on the Next 
button. A new window will open. 

9. Select Left arrangement of the captions and click on the Next button. 
A new window will open. 

10. The last screen of the wizard displays an overview of your selection. 
Click Finish to submit the settings and the form will be generated. 

11. Save the form to disk before running it. Click on the  button or 
select command Save from the File menu. 

12. To test the behavior of the form, run it by clicking on the  button 
or selecting the Run command in the Design menu. 

13. Type in the values for variable fields on the label. See how the label 
preview refreshes for each entered data.  

14. Click on the Print button to print the label to the default printer.  

15. Click on the Quit button to close the running form. 



Chapter 4: Other NiceLabel Applications  

 

 

88 NiceLabel Quick Start Guide 

 
The generated form file 

Note: To protect the form from any changes, make a shortcut to the 
form file on the desktop PC. If you double-click on the shortcut, 
the form will run and the operator will not be able to switch back 
to the design mode. 

4.1.2 Modify a Form 

You can edit or re-design forms with the NiceForm application. To do so, 
you must have sufficient access permission to the NiceLabel software. 
Designing forms in NiceForm is similar to label design in NiceLabel Pro. 
Both applications have similar working interfaces. 

To modify a form, do the following: 

1. Open NiceForm. 

2. Click on the  button or select the command Open in the File 
menu. 

3. Browse to and open the form file you want to modify. All NiceForm 
files have the extension XFF. 

4. Apply changes to the form. Use the Toolbox on the left side to place 
new objects on the form.  

5. Double-click the form objects to display and change their properties. 

6. Make your changes on the form and save the file. 
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4.2 Label Printing Using NicePrint 
NicePrint is a standalone application that enables fast and easy label 
printing. You can start NicePrint from the NiceLabel Suite program group 
in the Start menu. Using NicePrint, you can select all necessary printing 
actions in one single window: 

• Select the label for printing 

• Set the values for variables 

• Select records in the database 

• Change the printer and its properties 

• Define label quantity 

• See label preview 

• Print the label 

 
Application NicePrint provides fast access to label printing 

NicePrint is available in the NiceLabel Suite edition. 
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4.3 Automatic Label Printing 
NiceLabel software offers automatic and unattended bar code label 
printing. The integration middleware module NiceWatch is used to monitor 
different system events and triggers pre-defined actions upon the change. 

Existing databases and other sources of data can easily be used as the input 
for labels. A file dropped in any folder is detected and the data is extracted 
from the file and used on the labels. The whole process is automated and 
requires no user intervention. The integration middleware module 
NiceWatch handles several triggers at the same time and prints labels to 
any number of printers. 

Other detection methods include communication on the serial port, 
communication over the TCP/IP port and checking of e-mail messages on 
the mail server. 

The built-in filters gather the data from trigger events. Data can be 
manipulated with the powerful Visual Basic scripting. 

For more information about automatic label printing please refer to the 
NiceLabel User Guide, White Papers and tutorials on the NiceLabel Web 
site at www.nicelabel.com. 

4.4 Storing Fonts and Graphics to the Printer 
NiceLabel software provides fast and reliable label printing to thermal 
printers using the NiceDrivers which are optimized Windows thermal 
printer drivers. NiceDrivers support printer hardware accessories like 
cutters and different label sensors but also printer resident objects. Such 
objects are fonts and bar codes that are built into the printer. Printers 
always print labels that use resident objects very quickly because the driver 
generates a print file with references to the objects already stored in the 
printer's firmware. The print file is short and can be transferred quickly to 
the printer. 

When you print labels with graphic and non-resident objects all 
unsupported objects are converted to pictures and sent to the printer as 
graphics. This approach ensures that the label is successfully printed on 
every printer. But the printout speed various on different printers, 
depending on the number of objects that are recognized internally by the 
printer. 
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The solution for fast printing is available with the memory card manager 
NiceMemMaster which enables you to store on the printer 

• Windows fonts (true type, open type, type1 and other) 

• Pictures  

Fonts and pictures can be downloaded to the printer’s internal memory or 
add-on memory cards. The number of objects that can be downloaded is 
limited only by the memory size. 

Once the objects are stored in the printer, you do not have to send them to 
the printer again. The objects are re-called from the printer memory 
ensuring fast response at print time. Other applications can also take 
advantage of the downloaded objects and print labels quickly. 

The content of one memory card can be used on many labels. 

4.5 Managing Databases 
NiceLabel software provides the database management application 
NiceData. You can use NiceData to complete the following tasks: 

• Opening a database 

• Adding new records 

• Removing existing records 

• Search for data 

• Modifying database structure 

• Creating new database 
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5. Technical Support 

If you experience any technical difficulties using the NiceLabel software, 
the first thing to do is to refer to the on-line help and User Guides available 
on the NiceLabel CD. You will find a comprehensive How to section that 
explains how to use NiceLabel software. 

5.1 Online Support 
You can find the latest builds, updates, workarounds for problems and 
Frequently Asked Questions (FAQ) under the Support section on the 
product Web site at www.nicelabel.com. If you cannot solve the problem 
on your own, please contact your local vendor or representative offices 
listed in the chapter Contact Information. 

For more information please refer to: 

Support FAQ:  http://www.nicelabel.com/Support/FAQ

NiceLabel Tutorials: http://www.nicelabel.com/Learning-center/Tutorials

NiceLabel Forums: http://forums.nicelabel.com/

5.2 Contact Information 
 

Head Office:  North American Office: 

Euro Plus d.o.o. 
Ulica Lojzeta Hrovata 4c 
SI-4000 Kranj 
Slovenia 
Tel: +386 4 280 50 00 
Fax: +386 4 233 11 48 
support@nicelabel.com
www.nicelabel.com

 Niceware International, LLC 
10437 Innovation Drive 
Suite 147 
Milwaukee, WI 53226 
Tel: +1 414 476 NICE (6423) 
Fax: +1 414 476 7955 
Tech Support: +1 414 476 6408 
support@nicewareintl.com
www.nicewareintl.com

French Office:   

http://www.nicelabel.com/Support/FAQ
http://www.nicelabel.com/Learning-center/Tutorials
http://forums.nicelabel.com/
mailto:support@nicelabel.com
http://www.nicelabel.com/
mailto:support@nicewareintl.com
http://www.nicewareintl.com/
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NiceLabel France : 

Cobarsoft SARL  
6 rue Salengro 
ZI hippodrome 
32000 Auch 
France 
Tel: +33 (0) 562 709 201  
Fax: +33 (0) 562 708 004  
support@nicelabel.fr
www.nicelabel.fr

 German Office: 

NiceLabel Germany GmbH 
Liebknechtstr. 29 
63179 Obertshausen 
Germany 
+49 (0)6104 405 400 Tel 
+49 (0)6104 405 4020 Fax 
info@nicelabel.de
www.nicelabel.de

 
 
 
 
 

mailto:support@nicelabel.fr
http://www.nicelabel.fr/
mailto:info@nicelabel.de
http://www.nicelabel.de/
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6. Index 

A 

Activation, 18 
Activation Code, 22, 25, 29 
Edition Upgrade, 40 
Hardware Key, 19 
Network Edition, 19 
Network License Pack Upgrade, 44 
Network Upgrade, 44 
Network, Workstation, 31 
Parallel Key, 19 
Software Key, 19 
Upgrades, 37 
Version Upgrade, 37 
Web, on the, 21 

Alignment, Label, 57 

B 

Bar Code, 54 
GS1-128, 72 
Insert Bar Code, 54 

C 

Contact, 90 
Control Cutter, Printer, 79 

D 

Data, Serialized. See Variable Field 
Database, 65 

Advanced, 75 
Connect Label to, 65 
Format Data, 66 

NiceData, 89 
Select Data, 69 
Text, 65 
Text File Wizard, 66 

Date Variable. See Variable Field 
Demo Mode. See NiceLabel 
Design, Label. See Label Design 
Developer Series, 6 
Dimensions, Label, 50 

E 

GS1-128, 72 
Enterprise Print Manager, 19, 29, 30 
Enterprise Series, 5, 19 
EPM. See Enterprise Print Manager 
Express. See NiceLabel Express 

F 

Form. See NiceForm 
Function, 76, 78 

H 

Hardware Key 
Parallel Key, Installation and 

Activation, 19 

I 
Installation, 8 

Edition Upgrade, 34 
Hardware Key, 19 
Network Edition, 8, 15 
Network Edition, Workstation, 17 
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Network Upgrade, 35, 36 
NiceDriver, 12 
Parallel Key, 19 
Printer Driver, 12 
Single User Edition, 8, 9 
Software Requirements, 8 
System Requirements, 8 
Upgrade, 32 
Version Upgrade, 33, 35, 36, 41 

K 

Key number, 22, 25 
Keyboard Entry. See Variable Field 

L 

Label Design, 48 
Advanced Label, 72 
Basic Label, 49 
GS1-128 Compliance, 72 
RFID Smart Label, 80 

Label Printing, 59, 87 
Automatic Printing, 88 
Database, from, 71 
Preview, 59 
Print Preview, 69 
Printer Driver, Installation, 12 
Printer Settings, Change, 64 
Select a Printer, 50 

N 

Network Edition. See NiceLabel 
Network 

NiceData, 4 
Managing Database, 89 

NiceDriver. See Printer Driver 
NiceForm, 4, 83 

Create, 84 
Modify, 86 

NiceLabel 
Demo Mode, 32 
NiceLabel Express, 4 
NiceLabel Pocket PC Designer, 5 
NiceLabel Pro, 4 
NiceLabel Pro Print Only, 4 
NiceLabel SDK, 6 
NiceLabel Suite, 3 
NiceLabel Suite Print Only, 4 
Pocket NiceLabel, 5 
Product Overview, 3 
Software Package, Content, 6 

NiceLabel Express. See NiceLabel 
NiceLabel Network, 15 

Activation, 25, 31 
Installation, 15, 17 
System Requirements, 8 

NiceLabel Pocket PC Designer. See 
NiceLabel 

NiceLabel Print Center, 5, 19, 29, 31 
NiceLabel Pro. See NiceLabel 
NiceLabel Pro Print Only. See 

NiceLabel 
NiceLabel SDK. See NiceLabel 
NiceLabel Suite. See NiceLabel 
NiceLabel Suite Print Only. See 

NiceLabel 
NiceLabel WebSDK, 6 
NiceMemMaster, 4, 89 
NicePrint, 4, 87 
NiceWatch, 4 

Automatic Label Printing, 88 
NiceWatch Enterprise, 5 

O 

Object 
Bar code, 54 
Picture, 56 
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Rich Text Box (RTF), 78 
Text Box, 76 
Text, Non-changing, 52 

Online Support. See Support 

P 

Parallel Key. See Hardware Key 
Pocket NiceLabel. See NiceLabel 
Pocket PC Designer. See NiceLabel 

Pocket PC Designer 
Prefix, 63 
Print Center. See NiceLabel Print 

Center 
Printer Driver, Installation, 12, 13 
Printing. See Label Printing 
Pro Print Only. See NiceLabel Pro 

Print Only 
Product Overview. See NiceLabel 

R 

Radio frequency identification (RFID), 
80 
Design, Smart Label, 80 
RF tag, encode, 80 

Registration, 47 
Registration number, 22, 25 
Restrictions. See Software Restrictions 
RFID. See Radio frequency 

identification (RFID) 

S 

SDK. See NiceLabel SDK 
Serialized Data. See Variable Field 
Software Requirements, 8 
Software Restrictions, 7 
Standard Series, 3 
Suffix, 63 

Suite. See NiceLabel Suite 
Suite Print Only. See NiceLabel Suite 

Print Only 
Support, 90 
System Requirements, 8 

T 

Technical Support. See Support 
Time Variable. See Variable Field 

U 

Upgrade, 32 
Activation, 37 
Edition, 34, 40 
Installation, 32 
Network, 35, 36, 44 
Network, License Pack, 44 
Version, 33, 35, 36, 37, 41 

V 

Variable. See Variable Field 
Variable Field, 60 

Date, 62 
Keyboard Entry, 60 
Serialized Data, 61 
Time, 62 

W 

WebSDK. See NiceLabel WebSDK 
Wizard 

Activation, 22, 25 
GS1-128, 73 
Installation, 10 
Installation, Network Server, 16 
Label Setup, 49 
Printer Installation, 13 
Windows Add Printer, 14 
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